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This index lists all Help topics available for the Compose application. To learn how to use Help, press F1 
or choose Using Help from the Help menu.

Note that the Compose application and Help use the notation <sp> to refer to the space bar.
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New    (File Menu)
Creates a new set of compose sequences, which initially includes four pre-defined sequences:

1. Today's date, <Compose> D<sp>
2. Current Time, <Compose> T<sp>
3. Today's date and the current time, <Compose> DT
4. Choose dialog box, <Compose> <sp><sp>

To see the sequences, choose Compose==>Define Sequences. To save this set or any additions
to this set, choose File==>Save As.



Open    (File Menu)
Displays a dialog box listing the directories and files of previously saved sets of compose sequences. 
When you open a new set of compose sequences, he current set is discarded. See Open Dialog Box.



Save    (File Menu)
Saves the currently defined set of compose sequences to disk, using the filename that is displayed in 
the Compose application's main window. To save to a different filename, use Save As.



Save As    (File Menu)
Displays a dialog box where you can enter a filename for saving the currently defined set of compose 
sequences. See Save As Dialog Box.



Print Compose Sequences (File Menu)
Displays a dialog box from which you can print the current set of compose sequences. See Print 
Compose Sequences Dialog Box.



Print Font    (File Menu)
Displays a dialog box showing from which you can print all of the characters and technical information
of a font. See Print Font Dialog Box.



Print Font Samples    (File Menu)
Displays a dialog box from which you can select the fonts that you would like to print samples of. See 
Print Font Samples Dialog Box.



Exit    (File Menu)
Exits the Compose application. If you have made modifications to the current set of compose 
sequences and have not saved them, a message box provides an opportunity to do so.



Recently Used Files    (File Menu)
Displays the names of the eight most recently used compose sequence files. Choose one to load it, 
discarding currently defined compose sequences.



Preview Screen Fonts    (Compose Menu)
Displays a dialog from which you can preview all installed screen fonts. For each available    screen 
font, you can view the individual characters of the chosen font in different point sizes, bolding and 
underlining. You can also display the OEM and ANSI numeric value for a selected character. This 
dialog box is very similar to the Choose Dialog Box dialog box, but characters can not be selected 
and sent to an application.



Define Sequences    (Compose Menu)
Displays a dialog box from which you can modify the currently defined set of compose sequences by 
adding new sequences or deleting or editing existing sequences. See the Defining New Compose 
Sequences or Define Sequences Dialog Box.



Long/Short Date Format (Options Menu)
Controls the formatting of the string sent by the date (D<sp> and the date/time (DT) compose 
sequences. The long and short date formats are those defined by the Control Panel's International 
dialog box.



Enable/Disable Compose    (Options Menu)
Toggles the operation of the Compose application. Compose starts up enabled, so that it is monitoring
keyboard activity. If you suspect that Compose may be interfering with another application, choose 
Compose==>Disable. Use the Enable menu item to reactivate Compose.

Enable/Disable also appear on the control menu so that you can disable and enable Compose after it 
has been minimized. The control menu is the rectangle on the left side of the caption. When the 
Compose window is visible, click on this rectangle or type Alt-space to bring up the control menu. If 
Compose is iconic, single click on the icon to bring up the control menu.



Quick/Standard Access to Choose Dialog Box    (Options Menu)
Disables all compose sequences. The Choose dialog box immediately appear whenever you type the 
Compose key. See Choose Dialog Box.

Use this menu for easy access to symbol and "dingbat" fonts, where most of the characters of the font
are not alphanumeric. Select the menu item again to re-enable all compose sequences.



Move Pointer To Compose Indicator    (Options Menu)
Choose this menu item if you need the mouse pointer to move to the Compose indicator that appears 
in the bottom right portion of the screen. Typically this option is needed when there is software trying 
to raise windows to the top as the pointer moves around.



Flash Compose Indicator    (Options Menu)
Determines whether the Compose indicator flashes or not. The Compose indicator is the small 
window that appears in the bottom right corner of your screen when you begin a compose sequecnce.
By default, flashing is turned on so that accidentally entering Compose mode is more noticeable.



Set Key    (Options Menu)
Defines a new compose key. By default, the compose key is the Ctrl key located on the right hand 
side of the space bar. If your keyboard does not have this key, or you would like to define a different 
one, start by selecting the Set Key menu item. The Compose window displays a message instructing 
you to press and release the preferred key or keys.

Choose a key that is convenient to use, but will not conflict with other applications. Alt and Ctrl are 
allowed as modifiers. For example, F2      and Alt-F12 are valid keys. Remember that you can disable 
Compose if your preferred compose key conflicts occasionally with the accelerators of an application.

To restore the Compose key to the Ctrl key to the right of the space bar, choose 
Compose==>Default Key.

To leave Set Key mode without making any changes, press the Esc key.



Default Key    (Options Menu)
Restores the Ctrl key to the right of the space bar as the compose key. Use this menu item    if you 
have changed the Compose key to some other setting.



Compose Sequence

A mnemonic sequence of characters, often associated with a single character not found on the 
keyboard, or with a string. Some examples: pressing the compose key, then '1' and '2' would result in 
the character '½', 'c' and 'o' would result in the character '©', and 'd', 'e', and 'c' would result in the 
string "Digital Equipment Corporation".



View COMPOSE.TXT
Choose this menuitem to have Compose start the Notepad application so that the COMPOSE.TXT 
file can be reviewed.



Overview
You may want to maximize the window size before reading this section.
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The supported Windows method for entering a character not found on the keyboard is to hold down the 
Alt key while typing a value on the numeric keypad. Not only must you know the numeric value for the 
character that you want to enter, in some cases, you must press and hold multiple keys at once.

The Compose application provides a simpler alternative by giving you:

--    quick access to characters not found on your keyboard
--    application independent access to the current date and time
--    the ability to view, select from, and print out all the characters of a font
--    the ability to print samples of all available printer fonts

Many people who have used Digital Equipment Corporation terminals and workstations are familiar with 
using the Compose key and compose sequences to enter characters not found on the keyboard. You 
press the Compose key, then a two-character mnemonic that represents the desired character. For 
example, to enter the character ¢, you press the Compose key, then the c key and then the / key.

The Compose application supplies a set of predefined compose sequences, like the above, which are the 
same as those normally available on Digital terminals and workstations, with some additions. You can 
view all defined sequences by choosing Compose==>Define Sequences from the menu. You can 
also define new compose sequences or modify existing ones. For example, you could define the 
sequence CN to produce the string "My Company's Name."

The Compose application also supplies compose sequences that produce combinations of today's date 
and current time.

In addition, you can use a dialog box to display a list of all installed screen fonts and characters in the 
screen fonts. Double-clicking on any character enters that character into the current application. Use 
another dialog box to print all the characters of a font.

While Compose works with many Windows applications, it does not work with all applications. Compose 
needs to shift input focus around to do its work, and some applications are sensitive to this. However, you
can still use Compose as an aid for entering special characters. See Using Compose with Certain 
Applications for more information.

Assuming that you have Compose running right now, give it a try. 

Start up the Notepad application in the Accessories group. To create the strings on the left, enter 
the keystrokes on the right: Note that the default compose key (symbolized by C) is the Ctrl key to
the right of the space bar.

It took 1½ minutes. [It took 1C12 minutes.]
¿Aquí? [C??Aquci'?] 
4×2 + 4÷2 [4Cxx2 + 4C:-2]

Related Topics:



Using Compose Sequences
Defining a New Compose Key
Short Cut for the <sp><sp> Sequence

Defining New Compose Sequences
Viewing Currently Defined Compose SequencesPrinting Currently Defined Compose Sequences

Printing a Font
Printing Font Samples

Starting the Compose Application
Disabling and Enabling the Compose Application
Using WIN.INI



Using Compose Sequences
The Compose application window describes the key currently defined as the Compose key. By default it is
the Ctrl key to the right of the space bar.

To enter a compose sequence from the keyboard, press and release the Compose key. A flashing 
rectangular indicator titled "Compose" appears in the lower right corner of your screen. You may now type
the characters that make up the sequence, such as 'c' and 'o'. As soon as you've typed a valid compose 
sequence, the indicator disappears and the character or string that resulted from the compose sequence 
appears in your application.

If you enter an invalid compose sequence, you will hear a beep and the indicator will be titled "Invalid." 
This indicator will disappear in a few seconds. To abort any compose sequence, press the Esc key or the 
Backspace key.

Note:    While Compose can provide characters to an application, it cannot format them in that application.
You must use the application itself to assign font, style, and size.

For example, if you use Compose to send a character from the Symbol font to an application, you must 
set the application's current font to Symbol to see it.

Related topics:
Viewing Currently Defined Compose Sequences



Defining a New Compose Key
See Set Key.



Defining New Compose Sequences
Choose Compose==>Defines Sequences to define new compose sequences, as well as modify and 
delete existing ones.

To add a new compose sequence, you must decide on the sequence of characters that you would like to 
use. Compose sequences can be from one to five characters and must not conflict with existing compose 
sequences.

You must also decide on whether or not the compose sequence should be case sensitive. For compose 
sequences such as 'A', '^' for 'Â' and 'a', '^' for 'â', case is important. For compose sequence such as 
'c', 'o' for '©' and 'c', '/' for '¢', case probably is not important.

Another option for compose sequences is whether or not the characters must be specified in a specific 
order. For compose sequences such as '1', '2' for '½' and '1', '4' for '¼', it makes sense that they occur 
in a certain order. For compose sequences such as 'p', '!' for '¶' and '-', '+' for '±', order probably is not 
important.

See Define Sequences Dialog Box.



Viewing Currently Defined Compose Sequences
Choose Compose==>Defines Sequences to display a dialog box containing a list of currently defined
compose sequences. Normally, you use this dialog box to add, modify, and delete compose sequences, 
but it also serves as an easy way to view existing ones.

See Define Sequences Dialog Box.



Printing Currently Defined Compose Sequences
Choose File==>Print to print the currently defined compose sequences. This displays a dialog box 
where you can select the printer for a listing of currently defined compose sequences.

See Print Compose Sequences Dialog Box.



Printing a Font

Choose File==>Print to print the characters of a font, their character codes, and a sample string. This 
displays a dialog box where you can pick a font, size, and style to be printed.

See Print Font Dialog Box.



Starting the Compose Application

There are four ways to start Compose:

1.    Use the Run dialog box from the Program Manager's File menu.
2.    From the DOS command line: WIN COMPOSE.
3.    Add Compose to the "run=" line in WIN.INI: run=compose
4.    Add Compose to the "load=" line in WIN.INI: load=compose

Option 4 is generally the best method. Compose starts automatically and unobtrusively, and is ready 
when you need it.



Disabling and Enabling the Compose Application

If the currently defined compose key conflicts with your application, you can disable Compose rather than 
closing it down. Choose Options==>Disable Compose item to do this. After the problem area has 
been resolved, you can enable Compose again.

Disabling and enabling Compose can also be done from the control menu, allowing these actions to be 
performed from the Compose icon.



Using WIN.INI

BE CAREFUL WHEN MODIFYING WIN.INI WITH A TEXT EDITOR!

The following fields are maintained in the WIN.INI file under the "[Compose]" heading:

Files=
This field lists recently visited Compose data files. The contents of this string are appended to the File
menu. This line may be deleted to reset that list.

DiscardableMemory=
Compose normally uses discardable memory for its various tables. This allows Windows to discard 
the relatively unimportant tables of Compose sequences in low memory conditions. If the tables are 
discarded, there will be a long delay the next time that Compose is used while it reads the tables from
disk. Acceptable values are:

0 - Memory is not discardable.
1 - Memory is discardable (this is the default)

ChooseDialogFont=
The value of this field is maintained by the Choose and Preview Screen Fonts dialog boxes. The last 
font used in either of these dialog boxes is stored here so that later invocations of Compose can reset
the dialog box to its last context.

ChooseDialogPointSize=
The value of this field is also maintained by the Choose and Preview Screen Fonts dialog boxes. The 
last point size used in either of these dialog boxes is stored here.

ShowScancode=
This field can be used to obtain the scancode of the key that is currently the Compose key. Usually 
this information is not needed, and therefore is not displayed. However, for setting up a new Compose
key under an unsual keyboard configuration, this field can be useful. Acceptable values are:

0 - scancode is not displayed in the Compose window. (default)
1 - scancode is displayed

QuickAccessToFonts=
The value of this field is maintained by the "Quick/Standard Access to Choose Dialog Box" menu item
in the Options menu. Acceptable values are:

0 - The <sp><sp> sequence is needed to display the Choose dialog box where fonts are listed. 
(default)
1 - Only the Compose key is need to display the Choose dialog box.

LongDate=
The value of this field is maintained by the Long/Short Date Format menu item in the Options menu. 
This controls the format of the date returned by the D<sp> and DT compose sequences. Both formats
are defined by the Control Panel's International dialog box. Acceptable values are:

0 - Short date format is returned (default)
1 - Long date format is returned

MovePointer=
The value of this field is maintained by the Move Pointer to Compose Indicator menu item in the 



Options menu. Some applications, such as those that automatically raise windows and set focus as 
the pointer moves around, may get confused if the Compose indicator appears but the pointer is over 
another window. If this field is set, Compose will move the pointer over the Compose indicator light 
until the sequence is finished, and then move it back. Acceptable values:

0 - Off, pointer does not move (default)
1 - On, pointer does move

FlashIndicator=
The value of this field is maintained by the Flash Compose Indicator menu item in the Options menu. 
If set, this field causes the Compose indicator to flash when a Compose sequence is started. The 
flashing indicator is an aid to determining accidental entries into Compose mode. Acceptable values:

0 - Off; indicator does not flash
1 - On; indicator does flash (default)

FlashMilliseconds=
The value of this field indicates the flash rate of the Compose Light indicator. By default this value is 
300 milliseconds.



Open Dialog Box

Use the Open dialog box to open a file of previously saved compose sequences. 

Open File Name edit field:
Enter a file name or file filter in the Open File Name field. If no drive and directory are specified, 
the drive and directory specified in the Files In field will be used. Wildcards, such as *.DAT and 
ABC??.DAT, may be used in this field to cause the listbox to list files matching that wildcard 
pattern.

The list box also displays items such as "[..]" which means go up one level in the directory tree, or
"[subdir]" which means go to a subdirectory, and "[-c-]" which means go to a drive.

Ok button:
To select a file, select it with the mouse or keyboard and click on Open or press the Enter key. 
You can also double click on a filename in the listbox to open that file.

Cancel button:
To leave the dialog box without opening any file, click on Cancel or press the Esc key.



Save As Dialog Box

Use the Save As dialog box to save the current set of compose sequences to a different file than that 
which was loaded, or to save a new set of compose sequences.

Save File As edit field:
Enter a valid filename in the Save File As field. If no drive or directory is specified within this field, 
the drive and directory displayed above this edit field will be used. Wildcards are not allowed.

Ok button:
To save the current set of compose sequences to the file named in the edit field, click the Ok 
button or press the Enter key. If the file specification is invalid (such as an incorrect drive letter or 
a misspelled directory, you will hear a beep.

Cancel button:
To leave the dialog box without saving the compose sequences, click on Cancel or press the Esc 
key.



Print Compose Sequences Dialog Box

Use the Print Compose Sequences dialog box to print the entire set of compose sequences to one of the 
available printers. The listing will show the characters of the compose sequence, indicate whether the 
sequence is order sensitive, and/or case sensitive, and show the string that results from the compose 
sequence.

Printer listbox:
Displays the names of all available printers. If the printer you need is not listed, use the Control 
Panel's Printers application to add it or to make it active.

Ok button:
To print all the currently defined compose sequences to the printer highlighted in the dialog box, 
click on Ok button or press the Enter key.

Cancel button:
To dismiss the dialog box without printing any listing, click on Cancel or press the Esc key.

Setup button:
To display the Setup dialog box of the printer currently highlighted in the Printers listbox, click on 
Setup or press Alt-S.



Print Font Dialog Box

Use the Print Font dialog box to preview and print all the characters of a particular printer font.

Printer listbox:
Displays the names of all available printers. If the printer you need is not listed, use the Control 
Panel's Printers application to add it or to make it active.

Ok button:
To print a listing of the characters of the selected font, click on Ok or press the Enter key.

Cancel button:
To dismiss the dialog box without printing any listing, click on Cancel or press the Esc key.

Setup button:
To display the Setup dialog box of the printer highlighted in the Printers listbox, click on Setup or 
press Alt-S.

Fonts listbox:
Lists all fonts currently available for the printer highlighted in the Printers listbox. The font 
highlighted when you click on Ok is the font that will be printed. Clicking on a font causes the 
Point Size combo-box to be reset with valid or typical point sizes for that particular font.

Point Size combo-box:
The drop-down listbox lists the point sizes ranging from 8 to 96 for scaleable printer fonts, or 
those sizes supported by the printer for non-scaleable fonts. If you enter a value in the edit field 
portion of the combo-box, Compose attempts to print the font in that size, but the quality and 
availability depend upon the font, the printer, and Windows.

Bold check-box:
Toggling this field causes the font to be bolded.

Italic check-box:
Toggling this field causes the font to be italicized.

Technical Info check-box:
Toggling this field causes technical details about the font to be printed. Details include standard 
and extended text metrics as well as a box around each glyph showing overall character 
boundaries, baseline, width, and internal leading.

Sample String edit field:
The contents of this field will be printed out on a separate page, using the selected font, after all 
the characters in the font have been printed.



Print Font Samples Dialog Box

Use the Print Font Samples dialog box to preview availble printer fonts.

Printer listbox:
Displays the names of all available printers. If the printer you need is not listed, use the Control 
Panel's Printers application to add it or to make it active.

Ok button:
To print sample strings of all selected fonts, click on Ok or press the Enter key.

Cancel button:
To dismiss the dialog box without printing any listing, click on Cancel or press the Esc key.

Setup button:
To display the Setup dialog box of the printer highlighted in the Printers listbox, click on Setup or 
press Alt-S.

Fonts listbox:
Lists all fonts currently available for the printer highlighted in the Printers listbox. This is a multiple
selection listbox, so that you can select multiple fonts for which you would like sample strings to 
be printed.

Select All push button:
Select all fonts listed in the Fonts listbox.

Point Size edit field:
Compose attempts to print the font in this size, but the quality and availability depend upon the 
font, the printer, and Windows.

Bold check-box:
Toggling this field causes the fonts to be bolded.

Italic check-box:
Toggling this field causes the fonts to be italicized.

Sample String edit field:
The contents of this field will be printed using each of the selected fonts.



Choose Dialog Box

The Choose dialog box whenever you enter the <sp><sp> compose sequence.    Use the Choose dialog 
box to select a character to send to an application. You need not remember the compose sequence.

Note: While Compose can provide characters to an application, it cannot format them in that application. 
You must use the application itself to assign font, style and size. For example, if you use Compose to 
send a character from the Symbol font to an application, you must set the application's current font to 
Symbol to see it correctly.

If viewing symbol and dingbat fonts is your primary use of Compose, consider using the Change to 
Change to Quick/Standard Access To Choose Dialog Box feature.

Also, note that you can copy a character to the clipboard by selecting it from the listbox of characters then
choosing Copy Character to Clipboard from the dialog box control menu. To display the control menu, 
click on the rectangle left of the dialog box caption or press Alt-Space.

Characters listbox:
Lists all the characters of a screen font. The size and style of the characters is determined by 
other fields in the Choose dialog box. When you select a character, the OEM and ANSI code 
fields update. You may notice the first character code of many fonts is not 0 nor is the last 
character 255. This is normal for Windows ANSI fonts. You can select a character and click on Ok
to send that character to your original application. You can also double click on the character. 
Either of these actions then dismisss the Choose dialog box so that you can continue your work..

Fonts listbox:
Lists all the available screen fonts. Note that these are screen fonts, not printer fonts. You may 
see a different list of fonts if you go to the Print Font dialog box. However, there often is a printer 
font for a corresponding screen font, especially with the emerging technology of scaleable fonts 
for Windows.

Bold check-box: 
Bolds or un-bolds the characters in the characters listbox.

Italic check-box:
Italicizes or un-italicizes the characters in the characters listbox.

OEM and ANSI fields:
Displays the value of the corresponding OEM or ANSI character codes of the character 
highlighted in the characters listbox.

« and » buttons:
Use these two buttons to reduce and enlarge the size of the characters displayed in the 
characters listbox. The current point size is displayed just above the scrollbar, between these two 
buttons. Where the scrollbar changes the point size by half the distance between the current 
position of the slider and the end position, these two buttons reduce and enlarge the font in more 
common point sizes.

Point size scrollbar:
Displays as well as changes the point size of the characters shown in the characters listbox.

Ok button:
Sends the currently selected character to the originating application. Compose attempts to 
determine whether to send the OEM or ANSI code. The dialog box is dismissed and returns focus



to the originating application.

Cancel button:
Dismisses the dialog box and returns focus to the originating application.

Print button:
Displays the Print Font dialog box. Compose attempts to initialize the Print Font dialog box with 
corresponding values from the Choose dialog box. See Print Font Dialog Box.



Define Sequences Dialog Box

Use this dialog box to view, add, delete, and replace compose sequences. Note that this dialog box does 
not cause the sequences to be saved to disk. Choose File==>Save or Save As to do that.

The following special codes allow you to enter non-standard characters into a compose sequence result:

\n Enters a carriage return into the string

\t Enters a tab into the string

\xnn Enters a character defined by a hex code into the string. (e.g. \xA2)

\dnn Enters a character defined by a decimal code into the string

Sequences listbox:
Lists all compose sequences by displaying the characters of the sequence, whether it is case 
sensitive, whether it is order sensitive, and the resulting string.

To modify or delete a sequence, first select it from this listbox.

Use the edit fields and check-boxes below the listbox when adding or modifying sequences.

Ok button:
To dismiss the Define Sequences dialog box and retain the changes, click on Ok. This does not 
save this set of compose sequences to disk.

Cancel button:
To dismiss the Defines Sequences dialog box without making any changes to the current set of 
compose sequences, click on Cancel.

Add button:
To add the compose sequences defined in the fields below the listbox to the list of defined 
compose sequences, click on Add. Limited checking is done to help avoid conflicts with other 
compose sequences.

Replace button:
To replace the definition of a compose sequence, first select it from the listbox. This fills in the 
fields below the listbox. Edit the compose sequence and click on Replace to replace the old 
definition with the new. Limited checking is done to help avoid conflicts with other compose 
sequences.

Delete button:
To delete a compose sequence, select it from the listbox and click on the Delete button.

Choose button:
To access to nonkeyboard characters when defining a compose sequence, click on Choose. This 
displays the Choose dialog box so that you may scan fonts and select the character that you 
need.



Using Compose with Certain Applications

While Compose works with many Windows applications, it won't work with all Windows applications. 
Compose needs to shift input focus around to do its work, and some applications are sensitive to this. If 
this is a problem you can still use Compose to access special characters. If the application can paste text 
from the clipboard, use the <sp><sp> compose sequence to display the Choose dialog box. Instead of 
double-clicking on a character, single click on it and choose Copy Selected Character from the control 
menu. To display this menu, single click on the rectangle to the left of the dialog box's caption or press Alt-
Space. After copying the character to the clipboard, click on Cancel or press Esc to dismiss this dialog 
box. You can now Paste the character from the clipboard. If the target application or window doesn't 
support the clipboard, select a character and note its ANSI code. Cancel the dialog box and return to your
application. While holding the Alt key down, use the numeric keypad to type in the numeric code; you may
need to turn NumLock on.




